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Safety and approval information

This Rosemount product complies with all applicable European directives when properly installed in accordance with
the instructions in this manual. Refer to the EU Declaration of Conformity for directives that apply to this product. The
EU Declaration of Conformity, with all applicable European directives, and the complete ATEX installation drawings
and instructions are available on the Internet at Emerson.com or through your local Emerson support center.
Information affixed to equipment that complies with the Pressure Equipment Directive can be found on the Internet
at Emerson.com.
For hazardous installations in Europe, refer to standard EN 60079-14 if national standards do not apply.

Other information
Full product specifications can be found in the product data sheet. Troubleshooting information can be found in the
maintenance and troubleshooting manual.
Product data sheets and manuals are available on the Emerson website at Emerson.com.

Return policy
Follow Emerson procedures when returning equipment.
These procedures ensure legal compliance with government transportation agencies and help provide a safe working
environment for Emerson employees. Emerson will not accept your returned equipment if you fail to follow Emerson
procedures. Return procedures and forms are available on our website at Emerson.com or by phoning the Emerson
Customer Service department.

Emerson Flow customer service
• Worldwide: flow.support@emerson.com
• Asia-Pacific: APflow.support@emerson.com
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1  Routine Maintenance
1.1  Meter maintenance

This section includes discussion of the maintenance of Rosemount 3814 Liquid Ultrasonic
Flow Meters.
For reference, you may download the MeterLink Quick Start Manual.

 CAUTION
SURFACE TEMPERATURE HAZARD
Meter body and piping may be extremely hot or cold.
Wear appropriate personal protective equipment when coming in contact with the meter.
Failure to comply may result in injury.

 CAUTION
TRANSPORTATION HAZARD
When moving the meter, do not insert the forks of a forklift into the bore.
Inserting the forks may cause the meter to become unstable, resulting in injury to
personnel or damage to the bore and sealing face.

NOTICE
Prior to lifting the unit, refer to the flow meter nameplate or outline dimensional (general
arrangement) drawing for the assembled weight.

 CAUTION
TRIPPING HAZARD
Clear all obstacles or obstructions from the work area when transporting, installing or
removing the meter.
Failure to comply may cause injury to personnel.
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 WARNING
CRUSHING HAZARD
Do not remove flange stabilizers.
Attempting to do so may allow the meter to roll, resulting in serious injury or equipment
damage.

Figure 1-1: Flange stabilizers

A. Flange stabilizers

 CAUTION
ESCAPING FLUIDS HAZARD
The purchaser of the meter is responsible for the selection of Emerson components/seals
and materials compatible with the chemical properties of the measurement fluid.
Failure to select suitable meter components/seals may cause escaping fluids, resulting in
injury to personnel or equipment damage.

1.2  Field hydrostatic pressure testing procedures
The Rosemount™ 3814 Liquid Ultrasonic Flow Meter can be hydro-tested without any
special preparations. The transducers are not exposed to the process pressure and can
remain installed in the meter.
The liquid ultrasonic meter pressure containing parts include but are not limited to the
transducer housings. These pressure containing parts are pressure tested while attached
to the meter body as a completed ultrasonic meter assembly. The hydrostatic test is
verification of the pressure containing capability of the liquid ultrasonic meter pressure
containing parts and the seals that seal them.
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 CAUTION
LEAKAGE OR PRESSURE CONTAINING PARTS FAILURE
Use precautions to eliminate hazards to personnel in the event of leakage or failure of the
liquid ultrasonic meter pressure containing parts or failure of the test equipment and to
prevent over-pressurization during the test procedure.
Failure to comply may result in injury to personnel or cause damage to the equipment.

1.3  Routine maintenance
Routine maintenance operations requires adherence to all applicable regulations and laws
and safety training for personnel to perform the maintenance operations. Review your
organization’s best practices procedures before performing routine maintenance.

1.3.1  Maintenance logs and reports
To monitor the performance health of the meter, and ensure it is operating
within acceptable specifications, routine diagnostics should be performed. Collecting a
maintenance log gives you a snapshot of the current health of the meter and you can
compare the inspection reports from previously saved logs. Use the Logs/Reports menu
and click Maintenance Logs and Reports. MeterLink™ displays the Maintenance Logs and
Reports dialog. Choose the time duration, log format and collection rate for the output file
and click the Start button. You can open the file immediately after it is generated or view it
at a later time. It is recommended that a maintenance log be collected after an upset in the
system.
In establishing a baseline to be used for the trending of the meter diagnostics, it is very
helpful if a set of log files are collected immediately after the meter has been installed in
the field. Preferably, collect the log files at several velocities within the operating range of
the meter. This helps establish that the flow profile is relatively constant throughout the
meters operating range (except velocities below 3 ft/sec where the profile may vary).
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Maintenance log collection

Figure 1-2: Maintenance log collection parameters

Trend maintenance log collection
Merging the results of two or more maintenance logs into a single file, allows you to build
a historical database of the meter’s performance. Trending the logs indicates changes from
the original installation of the meter, or over time. Looking at a single inspection report,
that is either collected monthly or quarterly, can give you an indication of the meter's
health.
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Figure 1-3: Trend log collection

This is important since many diagnostics change slowly over time. Trending the
maintenance logs helps identify these changes and makes problems much more obvious
than merely viewing a single inspection report. The trending feature is integral to
MeterLink which allows all important parameters to be trended. MeterLink supports
trending files in a Microsoft® Excel® workbook from multiple 3814 meter maintenance logs.
Some parameters like gain, signal level, and noise level may show a shift over time which
can be useful in detecting changes in the meter and the installation.
Maintenance logs or trend files to be trended must all have matching column headings.
This means the logs must be in the same units (i.e. U.S. Customary or Metric), must have
the same pressure type (i.e. gauge or absolute), and must have the same time base (1/
second, 1/minute, 1/hour, 1/day). If not, an error message will be displayed stating the
column headings do not match and the file will not be added to the Workbook to trend list.
Archive log collection
Archive logs that may be collected and the options include:
• Daily log - generated every 24 hours on the contract hour.
• Hourly log - generated every hour at the top of the hour.
• Event log - collects the alarm and event log records.
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Figure 1-4: Archive log collection parameters

The logs may be collected in a single file or you can choose to collect one type of log. Each
of the Meter Archive logs include the Meter Configuration file.
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1.3.2  Pipeline cleaning maintenance
 WARNING

BURST HAZARD
Before pipeline cleaning and maintenance (“pigging operations”), remove straightening
vanes or flow conditioners. Failure to do so may cause excessive pressure in the meter
system, resulting in serious injury/death or equipment damage.

Figure 1-5: 3814 liquid ultrasonic flow meter with flow conditioner for uni-directional
flow

A. Flow conditioner straightening device
B. Flow

Figure 1-6: 3814 liquid ultrasonic flow meter with flow conditioner for bi-directional
flow

A. Flow conditioner straightening device
B. Flow

Straightening vanes or flow profilers must be removed during pipeline cleaning
maintenance operations (“pigging operation”). If the meter run is pigged with a flow
conditioner in line, pressure may build up and cause the pipes and flanges to burst
and severely injure personnel. The excessive pressure may damage the meter or
the transducer ports may collect debris which may impede data acquisition and flow
measurement.
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1.3.3  High Viscosity piping requirements
The piping requirements for High Viscosity meter applications are shown in Figure 1-7.

 CAUTION
HIGH VISCOSITY FLOW MEASUREMENT METER RECALIBRATION
In high viscosity meter applications, if the connection between the upstream meter flange
(Figure 1-7, Item D) and the Venturi reducer (Figure 1-7, Item C) is disassembled or
disturbed for any reason, the meter will need to be recalibrated in accordance with
Rosemount recommendations. Alignment of this flange joint is critical in the performance
of the meter. It is recommended to consult Emerson Customer Support for assistance
when re-aligning this joint.
Failure to recalibrate the meter and correctly reinstall the flanged joint will result in faulty
flow measurement.

Figure 1-7: High Viscosity meter tube and Venturi piping requirements

A. Meter tube
B. Flow conditioner and flange gaskets
C. Venturi conical reducer
D. Upstream meter flange
E. 3814 Liquid Ultrasonic Flow Meter
F. Pressure tap
G. Temperature tap
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2  Troubleshooting
2.1  Meter status alarms

Run MeterLink™ and open the Meter Monitor (Summary) view to perform a diagnostics
health check.

Figure 2-1: Meter Monitor status alarms

If the meter is measuring flow and operating within the calibration parameters the Meter
Status LED is green. If the Meter Status LED is red, an active alarm exists that requires
you to take corrective action. Click the Check Status button to display the Status Summary
screen. The alarms are shown with the primary causes listed first. Click the question mark,

, next to the alarm to display a help topic related to the alarm and recommended actions
to resolve the issue.

Figure 2-2: Status Summary
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2.1.1  Check status
Click the Check Status button if any of the LEDs are yellow or red to see more specific
information causing the status alarm. Some alarms do not require an acknowledgement
and will clear automatically when the alarm condition goes away. Alarms that require a
user to acknowledge them will have a button to the right titled ACK. Clicking the ACK
button changes the button text to Wait and sends a request to the meter to clear the
alarm. The alarm will disappear from the Check Status dialog once the alarm actually
clears.
Click the Check Status button and MeterLink™ opens the Status Summary dialog box that
gives a short description of all alarms present.

Figure 2-3: Status Summary

A. Active alarm conditions from Meter Monitor page
B. Status Summary page with alarm examples

Following is a list and a brief description of the types of alarms:
• System
• Power loss
• Field I/O
• Validity
• Comms
• Check Status

2.1.2  System alarm
The System alarm indicates a failure in the hardware that should be addressed by a service
technician. This includes memory checksum errors and communication errors within the
hardware. A Red LED indicates a System alarm condition. Collect a maintenance log and an
audit/alarm log and then, contact your Emerson Flow service representative.

2.1.3  Chord A, Chord B, Chord C, and Chord D alarm
Chord A, Chord B, Chord C, and Chord D - These alarms indicate how a chord is
functioning.
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LED Color Problem
Green No alarms are present. Chord is operating properly.
Yellow At least one sample in the batch caused an alarm but it did not

cause the chord to fail. The sample will not be used in the batch.
Discarding occasional samples can occur during normal operation
such as during flow velocity changes.

Red The chord has failed or is in acquisition. This chord is not used for
this batch. Chords that have failed or are shown to be in acquisition
for repeated batches indicates that the meter should be inspected
by a service technician.

Gray The chord has manually been set to inactive, or option is not
available.

2.1.4  Field I/O alarm
Reports various field I/O devices that are in alarm. Click the Check Status button for more
details on specific alarms. The field does not appear if the meter does not support this
alarm.

2.1.5  Validity alarm
This alarm indicates that the meter may not be measuring accurately. Click Check Status to
see a description of which validity alarms are active. The validity alarms QMeter and QFlow
indicate an issue with the meter, collecting enough information from the chords to make
an accurate measurement. The validity alarms for pressure and temperature indicate that
the value is above or below the alarm limits for these values. Red and green are the only
colors used for this alarm.

2.1.6  Comms alarm
The Comms alarm indicates that communications between MeterLink™ and the meter
failed. This could be due to a poor communication link. MeterLink continues to retry
communications. Red and green are the only colors used for this alarm.

2.1.7  Communications
The Communications Analyzer (via MeterLink™ Tools → Menu → Communications Analyzer
menu path) displays communications between MeterLink and the ultrasonic meter. This
utility is useful for troubleshooting communications to the meter. It displays many of the
TCP/IP commands between MeterLink and the connected meter.

2.2  Troubleshooting the meter
The following sections show errors that may occur with the meter hardware, firmware or
connections and recommended actions to resolve the problem(s).
Error
Acquisition Module Error
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Recommended actions
1. Check interconnect cable between Acquisition Module and the CPU Module.
2. Attempt the Program Download procedure to install the firmware.

a) Cycle power to the meter.
b) Replace the Acquisition Module.
c) If the Acquisition Module cannot be reprogrammed, collect a complete

Archive log and contact your local area Emerson Flow service
representative.

Error
Acquisition Module is not compatible with firmware

Recommended actions
1. Upgrade the firmware in the meter to the latest version using MeterLink.

Contact your Emerson Flow service representative to obtain the latest firmware
or download the firmware from: Emerson.com.

2. Replace the Acquisition Module.
Error
Chord failure

Recommended actions
Chord is hard failed (Chord A, Chord B, Chord C or Chord D) and meter is unable to obtain
measurement data from this pair of transducers.

1. If Chord A is failed and no other transducers are failed or are reporting
status alerts, the issue is most likely isolated to this pair of transducers or its
cabling. Check the transducer wiring for this pair of transducers to make sure
connections are secure and wired correctly.

2. Verify that the meter run is not partially full where the top transducer pair are
not submerged in the process fluid.

3. Verify the average gain of this transducer pair is not above 90 dB. The gain
value can be read in MeterLink on the Monitor page.

4. Remove the transducer cable from the transducer and measure the resistance
with an Ohm meter across the two pins on the back of the transducer housing.
If the value is over 2 ohms, replace the transducers.

5. If transducer cabling allows, swap cabling of failed transducer pair with a pair
with equal path lengths. If the alarm remains active for this chord, then the
transducers are working properly. If this alarm clears but the chord that was
swapped now fails, the issue is with the transducer.

6. Collect a Maintenance Log, Configuration file and Waveform stream file with
MeterLink and contact your Emerson Flow service representative.

Error
CPU Module LINK LED

Recommended actions
1. When connecting directly:

a) Use a cross-over cable connection (P/N 1-360-01-596).

2. When Using a Hub:
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a) Use straight-through patch cable between the meter and the hub and a
straight-through patch cable between the hub and the PC.

b) Do not connect either the meter or PC to the hub UPLINK port.
c) Check the CPU Module LED1 is on (either solid red or flashing green). If

the LED is not on, check power to the meter.
d) If the LED is on, check the Ethernet cable connections.

Error
CPU Module LINK LED is on but I can't communicate with the meter using Ethernet

Recommended actions
If you are connecting for the first time:

1. Enable the DHCP switch on the CPU Module.
2. Verify that the PC has received an IP address from the meter as follows:

a) Bring up Command prompt window (Start → Run-(type) cmd)
b) In the Command prompt window, type ipconfig

3. If you get the following: IP 192.168.135.35 (note the last .35 can be up to .44)
with a Subnet Mask of 255.255.255.0 and Default Gateway you should be able to
connect to the meter.

4. If you get the following:
a) Ethernet adapter Local Area Connection 1

IP Address: 0.0.0.0

b) The PC has not yet received an IP address from the DHCP server wait (up
to 30 seconds) to receive an IP address before attempting to connect to
the meter.

c) After 30 seconds the PC has not received an IP address from the DHCP
server or the IP address shown above (from ipconfig) is different from
the range of 192.168.135.35 through 192.168.135.44, verify that the PC is
configured to receive its IP address automatically (via DHCP).

Error
Communication line connected to the flow computer but no signal is received

Recommended actions
1. Check for loose connections at the flow meter and the flow computer.
2. Check the CPU Module settings.

Error
Communication issues due to blocked network ports

Recommended actions
1. Blocked network ports on the computer running MeterLink or on a company

LAN can prevent connections to the meter or prevent certain features from
working. These issues may occur over Ethernet, Modem and Direct serial
connections. Reference the list of network ports used by MeterLink in the Help
file and the symptoms of having blocked ports. Contact your IT department for
assistance in resolving these issues.
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2. Error condition of a blocked network:
a) Cannot connect to a meter.
b) Cannot collect Archive log files.
c) Cannot view or stream waveforms in Waveform Viewer or Signal

Analyzer.
d) Cannot upgrade firmware.
e) Communications lost over serial or modem connections while MeterLink

is idle on a screen.

3. Symptoms of blocked network:
a) If a PING is blocked on this network port, serial or modem connections

could be lost after approximately 15 seconds of inactivity. This issue can
be confirmed by checking the log_meter log file in the Temp data folder.
The path of the Temp data folder is shown in the MeterLink About dialog.

b) A blocked FTP port will generally not prevent a connection to the meter,
but will prevent log collections and program downloads. A blocked FTP
port could prevent a connection in the event the meter is running a
newer version of firmware for which MeterLink does not currently have
a database configuration file. If this is a case, a message stating “Error
reading database config file dbconfig<databaseversion>.xml from the
meter.” will be displayed.

c) blocked DB API port will report “Error 10001 opening database
connection to <IP address>”.

d) A blocked Streaming port will report an error message “Unable to open a
control socket”. This will occur when opening the Signal Analyzer window
or clicking Read or Stream to File in the Waveform Viewer.

Error
Communicating with meter but all chords display failures

Recommended actions
1. Verify that the resistance of transducers is within specification (2 MΩ).
2. Check the Acquisition Module.
3. Check the interconnect cables between the Base Enclosure and the Transmitter

Electronics Enclosure.
Error
Cannot communicate with MeterLink program

Recommended actions
1. Ensure that the meter is properly powered.
2. Ensure that the computer cable is properly connected and check your interface

pins (RS-485 or RS-232).
3. Verify that the communication parameters of the MeterLink program are

correctly set.
4. Check RS-485 or RS-232 communication.

Error
Cannot communicate with AMS Trex™ Field Communicator
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Recommended actions
Refer to the AMS Trex Field Communication User’s Manual, Rev D. This manual may be
downloaded from the following location: AMS Trex .
Note
The 375 or 475 field communicators are now obsolete and replaced with AMS Trex field
communicator.

Error
Cannot communicate with AMS Device Manager

Recommended actions
Refer to the AMS help documentation and support at the following
website: www.emerson.com/en-us/catalog/automation-solutions/asset-reliability/ams-
ams-device-manager.

Error
Connect to multiple meters via Ethernet when they are on the same LAN

Recommended actions
1. Configure each meter with a unique user-specified IP address.
2. Contact your IT department for valid IP addresses for your LAN and Gateway

addresses.
3. Disable the DHCP server.

Error
Connect to multiple meters via Ethernet when they are on the same hub but not connected
to an intranet LAN

Recommended actions
1. Configure each meter with a unique user-specified IP address.
2. Assign each meter on the hub a unique IP address within the range

192.168.135.150 through 192.168.135.254 (Gateway address for each meter
may be left unconfigured as 0.0.0.0).

3. A PC may receive its IP address from an external DHCP server; in this case, one
and only one meter must have its DHCP server enabled (the DHCP server will
serve up to 10 IP addresses to PCs attempting to talk to all meters on the hub).

4. Once a meter's IP address is configured, the meter may be connected to the
hub and accessed using that IP address.

Error
Configuration changed

Recommended actions
One or more parameters have been modified in the meter's configuration.

1. Collect an Audit log using MeterLink in order to see what configuration
parameters changed and when they changed.

2. Save the configuration file.
Error
Configuration lost
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Recommended actions
The meter configuration has reset to default values and the meter is not configured
correctly to measure flow and the meter has performed a Cold Start.

1. Unless the Cold Start occurred after upgrading firmware, replace the CPU
Module.

2. If the cold start occurred after a firmware upgrade, fully re-configure the
meter from a previously saved configuration using the Tools → Edit/Compare
Configuration in MeterLink. For Rosemount™ Series 3810 Firmware v1.60 and
later, the user database must be either imported from a saved user database
using Meter → Manage Users dialog box or manually reentered using the same
dialog box.

Error
Electronics temperature is out of nominal range

Recommended actions
Temperature of the electronics is out of nominal operating range -40 °F or above 212 °F
(below -40 °C or above 100 °C) which could lead to a system failure.

1. Attempt to warm or cool the meter electronics housing.
2. If the electronics is mounted to the meter and the process fluid in the meter

is over 149 °F (65 °C), you must remote mount the electronics off of the meter
body.

3. Collect a Maintenance log using MeterLink while the meter is experiencing the
issue and contact your Emerson Flow service representative.

Error
Flow pressure is outside the alarm limits

Recommended actions
1. Start up issues:

a) Verify that there is voltage to the pressure sensor from either the meter's
power supply board or from an external power supply.

b) If using an analog pressure device, verify that the pressure sensor is
properly wired to the connector.

c) Verify the input is properly configured for your pressure input.
d) If using a flow computer to write pressure to the meter, verify that it is

properly writing to fixed flow pressure in the proper units.

2. Run time issues:
a) Adjust temperature of process fluid to within alarm limits.
b) If using an analog pressure device and input reading is 0, check if

IsAI2Avail is equal to 1 in the Meter Information dialog in MeterLink. If it
is not 1, either the I/O Board has been removed or is damaged. Reinstall
or replace the CPU Module if this value is 0.

c) If using an analog pressure device, verify that the pressure sensor is
working properly.

d) If using an analog pressure device, recheck wiring and switch settings.
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e) If a flow computer is writing values to the fixed flow pressure, verify
that the flow computer is still writing valid values without Modbus® write
errors.

f) Re-verify the pressure input settings are correct.

Error
Flow temperature is outside the alarm limits

Recommended actions
1. Start up issues:

a) Verify that there is voltage to the temperature sensor from either the
meter's power supply board or from an external power supply.

b) If using an analog temperature device, verify that the temperature
sensor is properly wired to the connector.

c) Verify the input is properly configured for your temperature input.
d) If using a flow computer to write temperature to the meter, verify that it

is properly writing to fixed flow temperature in the proper units.

2. Run time issues:
a) Adjust temperature of process fluid to within alarm limits.
b) If using an analog temperature device and input reading is 0, check if

IsAI2Avail is equal to 1 in the Meter Information dialog in MeterLink. If it
is not 1, either the I/O Board has been removed or is damaged. Reinstall
or replace the CPU Module if this value is 0.

c) If using an analog temperature device, verify that the pressure sensor is
working properly.

d) If using an analog temperature device, recheck wiring and switch
settings.

e) If a flow computer is writing values to the fixed flow temperature, verify
that the flow computer is still writing valid values without Modbus write
errors.

f) Re-verify the temperature input settings are correct.

Error
Program download failed during firmware upgrade

Recommended actions
If a meter experiences a power loss in the middle of a firmware upgrade, the meter
may become unresponsive and communications to the meter may not be possible. If
this occurs, contact Emerson Flow Support for assistance.

Error
No power to the unit

Recommended actions
1. Check that the correct voltage level is in the range of 11-36 VDC at the meter

(refer to the System Wiring Diagram in Engineering drawings).
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2. Check the main power source for blown fuse or tripped circuit breaker.
Reference your “as built” installation drawings for your location.

Error
One or more of the chords is not indicating a reading (reporting zeros)

Recommended actions
1. Check for loose connections at the cable connectors.
2. Check the resistance of the transducers (should be approximately 2 Ω).
3. Problem also may be caused by a bad Acquisition Board or interconnect cable.
4. Check system status in the MeterLink program for any flagged errors.
5. Check the CPU Module.
6. Check the resistance of the failed transducer.
7. If Chord A is not indicating, change the transducer cables from Chord B to chord

A. If Chord B then fails, the transducers are bad on Chord A.
Error
Power failure

Recommended actions
Meter has had power removed for a period of time or the meter restarted itself such as
after a firmware upgrade. The Audit log in the meter indicates the power fail time.

1. If this was an unexpected restart of the meter, verify the integrity of the power
to the meter and make sure that the voltage level is the in the range of 11-36
VDC at the meter.

2. If this was a known power fail or restart of the meter, just acknowledge this
alarm.

Error
Sound velocity is outside defined limits

Recommended actions
The meter's measured average sound velocity is outside the defined limits.

1. Verify that all chords are measuring the same speed of sound within about
0.15%. Look for alarms that indicate transducer problems and resolve any
of these issues. This could include failing transducers, debris buildup on
transducers, or incorrectly entered path lengths in the configuration.

2. If the chords agree, adjust the SSMin or SSMax using the Field Setup Wizard
in MeterLink so the meter's average speed of sound falls within these limits
(consult with an Emerson Flow service representative before changing these
parameters).

3. Collect a Maintenance log using MeterLink and contact your Emerson Flow
service representative.

Error
Waveform contains an excessive amount of noise

Recommended actions
Use the MeterLink Meter → Signal Analyzer to increase the StackSize until noise level
decreases (settings can be 1 (none) 2, 4, 8, or 16). If increasing the StackSize is not
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successful, try turning on the filter or consult with Emerson Customer Support if you
are unsure of how stacking a signal can affect the meter's operation.

2.2.1  Meter maintenance
The Monitor (Summary) includes the direction of flow measurement, velocity rate, units
of measurement, uncorrected or corrected flow (if applicable for your meter) and a bar
graph for a visual comparison between the velocities for each chord. This is the default
view displayed when you select Meter → Monitor from the toolbar.

Figure 2-4: Meter Monitor (Summary) view

Run MeterLink™ and open the Meter monitor (detailed) view to perform a diagnostics
health check and or adjust parameters for your site requirements. If you wish to use the
Monitor (detailed) dialog as the default view, click the checkbox in the lower portion of the
dialog box.

Figure 2-5: Meter Monitor (Detailed) view

The following details the information displayed in this dialog box:
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• Flow Properties Table - the table at the top of the Meter Monitor dialog box shows basic
information about the condition of the flow in the meter.

• Flow Velocity/Flow Ratios Bar Graph - provides a visual comparison between the velocities
for each chord.

• Chord Speeds of Sound Bar Graph - a visual comparison between the calculated speeds of
sound for each chord.

• Gain/Performance Bar Graph - provides either a visual comparison of the average of the
upstream and downstream gains for each chord or a visual comparison of the average
of the upstream and downstream performance for each chord.

• Signal to Noise Bar Graph - provides a visual comparison between the signal to noise
ratio for each chord direction.

• Meter Status Alarms - provides a visual indication of the meter’s status.
• Run time - displays how long the monitor screen has been collecting data.
• Meter Time - the time displayed is the time from the Ultrasonic meter.

Note
If the time displayed has a yellow background, that is an indication that the meter’s
time is more than 10 minutes apart from the PC’s time.

• Meter Data List - displays read-only data selected from the drop-down list.
• Chart - the chart utility displays the data collected for the value selected from the Chart

drop-down list.
Refer to Troubleshooting the meter for error resolutions and Table 2-1 for meter
maintenance hardware diagnostics.
Table 2-1: Maintenance
MeterLink utility Diagnostics Action(s)
Meter Monitor (Summary) view Check Status for active alarms • Meter Status LED is green

if there are no active
alarms. This indicates the
meter is measuring flow
and operating within the
calibrated parameters.

• Meter Status LED is red. This
indicates an active alarm.
Resolve and acknowledge
active alarms as displayed
on the Status Summary
page. Click the Help
button, , beside the
alarm description to display
information about the alarm
and recommended actions
to resolve the issue.
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Table 2-1: Maintenance (continued)
MeterLink utility Diagnostics Action(s)
Meter Monitor (Detailed) view Flow Profile • Flow profile ratios can be

viewed by clicking on the
arrows in the upper left of
the chart.

• The flow profile ratios for
chords A and D and chords
B and C should be equal
lengths.

• The flow velocity ratio
between chords A and D or
chords B and C should not
differ by more than 10%,
changes will be reflected
by the symmetry and flow
profile values.

• If the difference persists, the
flow conditioner (if installed)
should be checked for
blockages and if required
the upstream piping should
be cleaned.

• Per path Speed of Sound
(SOS) differences should not
be more than 0.35%, these
can be viewed by clicking on
the arrows in the upper left
of the chart. Negative values
are shown in blue.

• The SOS difference can
be caused by buildup on
the transducer, incorrect
geometrical and delay time
values and stratification at
lower velocities.

• Gains and Signal to Noise
Ratios (SNR) are displayed
in decibels and should be
compared to the initial
values in the maintenance
logs taken during the
calibration or initial start-up.

• The average chord signal
amplitudes should be
compared to the initial
values in the maintenance
logs.

• The Check Status chord LED
will turn from green to red
if a path is hard failed. The
issue or issues causing the
failure must be corrected
before the alarm can be
cleared.
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Table 2-1: Maintenance (continued)
MeterLink utility Diagnostics Action(s)
Meter Monitor (Summary) view
Meter Flow Properties Table

Flow velocity • Check the flow direction.
If reverse flow is detected,
check for valve leaks.

• If the meter run typically
has reverse flow when
flow is stopped, reconfigure
the ReverseFlowVolLmt to
allow a higher volume from
the Field Setup Wizard → 
General Page.

Meter Monitor (Detailed) view
Monitor Chart Selection list

Speed of sound • Compare Speed of Sound
deviation from measured
SOS relative to the average
SOS.

• Check the chord's SOS.
• Check and correct

geometry configuration
(pipe diameter, distance
between the transducers
(LA), and delay time).

• If present, resolve
transducer issues (failed
transducer, cabling or
debris buildup on the
transducer face, or
path length configured
incorrectly).

• Adjust SSMin or SSMax
only if other checks
pass (consult a Emerson
Flow Service representative
before making these
adjustments).

Meter Monitor (Detailed) view
Meter Data List

Electronics temperature out of
range

• Temperature of the
electronics is out of nominal
operating range below 40 °F
or above 212 °F (-40 °C or
above 100 °C) (-).
— Heat or cool the meter

electronics housing. If
operating temperature
exceeds 149 °F (65
°C), remote mount the
Transmitter Electronics
Enclosure.
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Table 2-1: Maintenance (continued)
MeterLink utility Diagnostics Action(s)

Meter Monitor (Detailed) view
Meter Data List

Electronics voltage out of range • Systems voltages are valid if
1.0 V, 1.2 V, 2.5 V, 3.3 V or
the Acquisition Module valid
voltages are 1.2 V, 2.5 V or
3.3 V.

• Replace the CPU Module if
one or more of the System
Voltages is out of range.

• Replace the Acquisition
Module if one or more of
the voltages is out of range.

MeterLink Tools Menu • Frequency output • Run the Frequency Outputs
test

• If the output reads zero,
you may require a pull up
resistor 1.2k OHM, 0.5 W.
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Table 2-1: Maintenance (continued)
MeterLink utility Diagnostics Action(s)

• Analog outputs • Run Analog Outputs test
• Verify outputs are within 4

mA - 20 mA range
— 0% = 4 mA
— 25% = 8 mA
— 50% = 12 mA
— 75% = 16 mA
— 100% = 20 mA

• Digital outputs • Run the Digital Outputs test
• Digital Output Content is

in relation to frequency
validity and flow direction
configuration and polarity.

Meter Electronics • Acquisition Module
communications error

• Check firmware revision and
upgrade if necessary using
MeterLink Tools → Program
Download.

• If the CPU Module LED 5
is not flashing green, check
interconnect cable between
acquisition Module and the
CPU Module.

• If the CPU Board LED 5 is
not flashing green, replace
Acquisition Module.

MeterLink Logs/ Reports Menu • Meter performed a Warm
start or a Warm start
required

• Meter performed a Warm
start:
— Collect an Archive event

log (Audit log) using
MeterLink to view
configuration parameter
changes and when they
changed.

• Warm start is required:
— When you make

changes to
the transducer
characteristics, sample
rates, the device
number, or a Modbus
map file.
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Table 2-1: Maintenance (continued)
MeterLink utility Diagnostics Action(s)
MeterLink Tools → Edit/
Compare Configuration menu

• Meter performed a Cold
start

• The meter configuration has
reset to default values and
the meter is not configured
correctly to measure flow.

• Unless the cold start
occurred after upgrading
firmware, you may need to
replace the CPU Module.

• If the Cold Start occurred
after a firmware upgrade,
you must reconfigure the
meter from a previously
saved configuration file
using the Edit → Compare
Configuration screen. For
Rosemount Series 3810
Firmware v1.60 and later,
the user database must
be either imported from a
saved user database using
Meter → Manage Users
dialog box or manually
reentered using the same
dialog box. Then clear the
latched alarm on the Status
Summary page.

MeterLink Logs/Reports Menu • Power failure • If this was a known power
fail or restart of the meter
just acknowledge this alarm
on the Status Summary
page.

• If this was an unexpected
restart of the meter, verify
the integrity of the power
to the meter and make sure
that the voltage level is in
the range of 11-36 VDC at
the meter.

• Collect a complete Archive
log and contact your local
area Emerson Flow service
representative.
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Table 2-1: Maintenance (continued)
MeterLink utility Diagnostics Action(s)
MeterLink Meter Monitor
(Summary) view

• Chord failure MeterLink • The meter is unable to
obtain measurement data
from a pair of transducers.

• The cause may be isolated
to one pair of transducers
or its cabling. Check the
transducer wiring for this
pair of transducers to make
sure connections are secure
and wired correctly.

• Verify that the meter run is
not partially full where this
top transducer pair is not
submerged in the process
fluid.

• Verify the average gain of
this transducer pair is not
above 90 dB. Read the
value from the MeterLink
Monitor Page or using AMS
under Service Tools → Path
performance.

• Remove the transducer and
clean the transducer face.
Reapply coupling fluid to the
transducer face and reinstall
(see Transducer removal
and installation).

Security seals • Endcap seals
• Endcaps latches
• Transmitter Electronics

Enclosure
• Base Enclosure
• Shroud seals

• Only authorized personnel
may remove security seals.
Follow your standard
operating procedure to
report seals that have
been tampered with or
removed and replace the
seals per instructions in
"Security seal installation"
in the Installation manual
(00825-0100-3812).

External ground wiring • Transmitter Electronics
Enclosure ground lug

• Inspect ground lug wiring
and make sure the wiring is
tightly secured.

Conduit seals • Transmitter Electronics
Enclosure

• Inspect the conduit sealant
and follow your standard
operating procedure to
report tampering with the
conduit sealant.

• Your operating procedures
may require a certified
electrician and company
witness to reseal the
conduit.
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Table 2-1: Maintenance (continued)
MeterLink utility Diagnostics Action(s)
Flanges • Inspect for leaks

• Inspect flange stabilizers
• Perform leak tests on

flanges.
• Ensure flange stabilizers are

installed.

 WARNING
CRUSHING HAZARD
Do not remove flange stabilizers.
Attempting to do so may allow the meter to roll, resulting in serious injury or equipment
damage.

2.2.2  Unable to connect direct serial or external serial modem
Ensure that you do not have more than one modem driver installed to the same COM
port. Typically this will only be necessary if you use one COM port to talk direct (serial
communications) and use the same COM port to connect to an external modem. This
is an apparent limitation in Microsoft’s® Dial-up Networking. If more than one modem
driver is installed for a particular COM port, Dial-up Networking will always use the last
driver installed regardless of what is selected. The only work around is to only install one
modem driver per COM port on the PC at a time. Refer to the MeterLink Quick Start Manual
(00809-0100-7630) for phone and modem details.

2.2.3  Unable to connect to meter
If you receive the error message “Unable to connect to meter” when trying to connect to a
Rosemount™ Liquid Ultrasonic Flow Meter, refer to the following:
• Ethernet connections
• Direct serial connections

2.2.4  Ethernet connections
If you received the error message "Unable to connect to meter" while trying to connect
over Ethernet, verify you have the correct IP address in the Meter Directory record. If
the meter is to assign the IP address, make sure the IP address is set to 192.168.135.100
and that the DHCP switch is ON position on the CPU Module. If the meter has a fixed
IP address, verify the IP address, Subnet, and Gateway are correct in the meter. Verify
your wiring to make sure you have a cross-over cable for a direct connection between the
meter and the computer. If going through a hub, verify that the computer and meter are
connected to the hub with straight-through patch cables.

2.2.5  Direct serial connections
Verify the switch settings on the CPU Module. Also verify your wiring between the meter
and the computer running MeterLink™ using the Field Wiring drawing DMC-004946. Verify
the Comms Address and Baud rate are correct in the Meter Directory record.
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For additional information on wiring and configuring the meter for the various
communication options, refer to the Installation manual (00825-0100-3814).

2.3  Troubleshoot maintenance log files and trend
files

2.3.1  Files do not appear in workbook
Maintenance Log files and Trend files that exist on the PC do not appear in the Microsoft®

Excel® workbooks tree under Trend Maintenance Logs.
This is most likely caused by the fact that the desired file or files are already open in
Microsoft Excel. Open files can not be verified as Maintenance Log files or Trend Files by
MeterLink and are left out of the list. Simply close the files in Microsoft Excel and then close
and reopen the Trend Maintenance Logs dialog box to include them in the list.

2.3.2  Microsoft® Excel® Log/Export options are not available
In order for the Excel log/export options to be available, Excel must be installed on the
machine and at least one printer must be installed under the Windows operating system.
If Excel is installed and you have printers installed but the Excel option is still unavailable, it
may be because Excel cannot access the printer driver information of the Windows default
printer. If the Windows default printer is a network printer and you are not currently
connected to the network, then Excel will most likely not be able to access the printer
driver information and MeterLink™ cannot use Excel to generate reports or logs.
One solution is to install a local printer on your machine tied to LPT1. The local printer
driver you installed can be for any printer and the printer does not actually have to exist
or be connected to the PC. If you install a local printer, you can configure MeterLink to
temporarily change your Windows default printer over to this local printer while running
MeterLink. Do this by selecting this local printer for the Override system default printer
selection in the Program Settings dialog. MeterLink will automatically change the Windows
default printer to the selected override printer when it starts and will set the Windows
default printer back to its original printer when it closes.

2.3.3  Maintenance Logs or Trend files are not created
Prerequisites
When using Excel®, some of the worksheets in the Maintenance Logs or Trend files are not
created.
If the Inspection sheet of the Maintenance Log file or the Charts sheet of a Trend files is
not generated, it is probably because Excel is not configured to allow MeterLink™ to run the
Visual Basic® script that generates the page. Excel can be configured to allow MeterLink to
run the Visual Basic script by following the instructions below.
To enable Excel to work with MeterLink, select Options under the File menu. Under the
Trust Center tab, click Trust Center Settings. Under the Macro Settings tab, select Trust
access to the VBA project object model.
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2.4  Meter reset mode
For Rosemount™ Series 3810 Firmware v1.60 and later, the meter supports a reset mode to
configure the meter back to default conditions.
There are two supported modes: Reset users and Cold start meter. Reset users will delete
all users in the user database and restore the factory default administrator username
and password. Cold start meter will return the entire meter configuration back to default
settings, clear all logs, delete all users in the user database, and restore the factory default
administrator username and password.
Prerequisites
• The default password is Administrator-XXXXX where XXXXX is the non-zero padded

central processing unit (CPU) serial number which can be found on a label on the CPU
module.

• Before proceeding, if you can still connect to the meter, it is recommended that you
collect the meter configuration using the Edit  → Compare Configuration screen and
export the user database using the Meter → Manage Users dialog box.

• The WRITE PROT switch must be off in order to cold start the meter. The users can be
reset with the switch on or off.

Procedure
1. Connect your computer with MeterLink™ to the meter that requires a reset using the

appropriate cable.
2. To put the meter in reset mode, transition the Port A Override switch on the CPU

module from the Off position to the On position three times within five seconds and
leave the switch in the On position after the third transition.
Tip
Use a retractable ballpoint pen with the ballpoint retracted as a tool to transition the
switch.
The meter will enter meter reset mode after five seconds and remain in meter
reset mode for up to two minutes or until a reset action is complete or the Port A
Override switch is moved to the Off position.

3. Within the two minutes, connect to the meter with MeterLink. A Meter Reset Mode is
enabled dialog box will appear.

4. Click the desired option to either Reset users or Cold start meter.
MeterLink will prompt you to confirm the operation. Once the operation is
confirmed, the meter will begin the selected reset operation. MeterLink will
disconnect from the meter once the operation has completed.

5. Connect to the meter again using the default administrator username and go to
Meter → Manage Users to set up new users and change the default password for
the administrator user.
• For added security, the default username for the administrator user can be

changed as well.
• If a Cold start meter operation was performed, you must reconfigure the

meter from a previously saved configuration file using the Edit  → Compare
Configuration screen.
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3  Meter maintenance
3.1  Important safety information

Follow these safety message instructions to avoid injury and equipment damage.

 CAUTION
SURFACE TEMPERATURE HAZARD
Meter body and piping may be extremely hot or cold.
Wear appropriate personal protective equipment when coming in contact with the meter.
Failure to comply may result in injury.

 CAUTION
TRANSPORTATION HAZARD
When moving the meter, do not insert the forks of a forklift into the bore.
Inserting the forks may cause the meter to become unstable, resulting in injury to
personnel or damage to the bore and sealing face.

 CAUTION
TRIPPING HAZARD
Clear all obstacles or obstructions from the work area when transporting, installing or
removing the meter.
Failure to comply may cause injury to personnel.

NOTICE
Prior to lifting the unit, refer to the Rosemount 3814 Liquid Ultrasonic Flow Meter
nameplate or outline dimensional (general arrangement) drawing for the assembled
weight.
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 WARNING
CRUSHING HAZARD
Do not remove flange stabilizers.
Attempting to do so may allow the meter to roll, resulting in serious injury or equipment
damage.

Figure 3-1: Flange stabilizers

A. Flange stabilizers

 WARNING
FLUID CONTENTS MAY BE UNDER PRESSURE
When the meter is under pressure, DO NOT attempt to remove or adjust the transducer
housing.
Attempting to do so may release pressurized fluid, resulting in serious injury for personnel
or equipment damage.
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 WARNING
FLUID CONTENTS MAY BE HAZARDOUS
The meter must be fully depressurized and drained before attempting to remove the
transducer housing. If fluid begins to leak from the transducer housing, immediately
reinstall it.
Failure to do so may cause serious injury or equipment damage.

A. Transducer housing

 CAUTION
ESCAPING FLUIDS HAZARD
The purchaser of the meter is responsible for the selection of Rosemount components/
seals and materials compatible with the chemical properties of the measurement fluid.
Failure to select suitable meter components/seals may cause escaping fluids, resulting in
injury or equipment damage.

 WARNING
CRUSHING HAZARD
During meter installation or removal, always place the unit on a stable platform or surface
that supports its assembled weight.
Failure to do so could allow the meter to roll, resulting in serious injury or equipment
damage.

Consult your Emerson Sales and Service representative to ensure you purchase the correct
components and seals for your application.
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3.2  Transducer field removal and installation
The liquid ultrasonic meter transducers are a spring-loaded assembly with the piezoelectric
element at one end and the electrical connection at the other end. Rosemount 3810 Series
Ultrasonic Flow Meters are supplied with transducers which are extractable while the line is
pressurized. The transducer shown below is a one-piece capsule that can be easily installed
or removed from the meter without depressurizing the meter.

Figure 3-2: Transducer (LT-01/LT-04/LT-08)

Figure 3-3: Transducer (LT-03/LT-05/LT-09)
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Figure 3-4: Transducer assembly

A. Transducer cable (P/N 1-360-01-600) (max. length 15 ft.)
B. Coupling nut
C. Transducer retainer
D. Transducer
E. Transducer housing locking ring
F. Transducer housing

3.2.1  Transducer removal and installation
 WARNING

CUTTING HAZARD
Sharp edges may be present on the meter.
Wear appropriate personal protective equipment when working on the meter. Failure to do
so may cause serious injury.

Prerequisites

Tools required:
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Figure 3-5: Tools required

A. Crescent wrench or channel lock pliers for cable glands and electrical conduit
B. 7/16-in. (12 mm) wrench
C. ⅜-in. drive ratchet wrench (10 mm)
D. ⅜-in. drive (10 mm) - at least 3.5-in. extension (89 mm) with 7/16 (12 mm) socket wrench
E. ¼-in. (7 mm) flat-blade screw driver
F. ⅛-in. (3 mm) flat-blade screw driver
G. Allen wrench - size 3 mm (P/N 2-4-9200-501)
H. Retaining ring pliers (P/N 1-504-90-043)

Note
7/16-in. (12 mm) socket wrench not shown.
6 mm T-handle Allen wrench not shown.

Supplies needed:
• Dow Corning 111(1) Silicone compound
• Dow Corning 200(1) Silicon oil
• Loctite® Nickel anti-seize compound
Procedure

1. Before removing and installing transducer(s), connect to the meter using MeterLink™

and collect and save a Maintenance Log and configuration files.
2. If installed, remove the security wire seals from the transducer cable connector

attached to the transducer cable nut and the transducer retainer attached to the
locking ring.

(1) Dow Corning 111 and Dow Corning 200 are trademarks of Dow Corning Corporation, U.S.A.
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Figure 3-6: Transducer security seal removal

A. Transducer cable connector to transducer cable nut security wire
B. Transducer retainer to locking ring security wire

 WARNING
DO NOT ATTEMPT TO REMOVE TRANSDUCER HOUSING LOCKING RING
Removing the locking ring may allow the transducer housing to unscrew from the
meter body while the meter is under pressure.
Release of fluid under pressure may cause injury to personnel resulting in injury to
personnel or damage equipment.

3. Do not remove the transducer housing locking ring to ensure that the transducer
housing does not unscrew from the meter body during this process. Place a wrench
on the 1-in. hex of the transducer retainer and unscrew it from the transducer
housing.

4. Use a pair of needle nose pliers to grab the indexing key of the transducer and pull
the transducer from the housing.

5. For LT-05 transducers only, place a small amount of the Dow Corning 111(1) Silicone
grease (P/N 1-360-01-651) on the face of the transducer to be installed. Using your
finger spread the silicone grease over the face of the transducer to create a thin,
even layer of silicone grease on the surface of the transducer face. There should be
no gaps or mounds of the silicone grease on the face of the transducer. Wipe off any
excess silicone grease from the sides of the transducer.

6. For all other transducers, place three drops of Dow Corning 200(1) Silicon Oil (12,500
Centistokes) (P/N 1-360-01-650) on the face of the transducer to be installed.

7. Place the new transducer into the transducer housing. Rotate the transducer so that
the alignment notch on the back of the transducer fits over the indexing pin on the
back of the transducer housing.

8. Screw the transducer retainer onto the back of the transducer housing. Ensure
the transducer housing threads are properly aligned (avoid cross-threading the
housing) with the meter body, then use a wrench on the 1-in. hex bolt, if necessary,
to screw it down until it is flush with the transducer housing. The transducer retainer
just has to be flush and should not be torqued down once it bottoms out.

9. Align the transducer cable connector with the indexing key on the back of the
transducer and hand-tighten the coupling nut to secure the cable. Insert the
transducer cable assembly into the housing in the meter body.
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Figure 3-7: Transducer installation

10. Repeat these steps for any other transducers that require replacement.
11. Once the transducer replacement is complete, use MeterLink Calibration → Zero

Calibration and select the Zero Calibration utility to re-zero the meter at no-flow
conditions.

12. Close your connection to CUI and install security seals on the transducers if required
(see Figure 3-6).
This completes the transducer removal and installation procedure.

3.3  Transducer housing removal and installation
Rosemount 3810 Series Ultrasonic Flow Meters utilize transducer housings that contain
the transducer and act as the pressure barrier between the transducers and the fluid.
Under normal maintenance such as transducer replacement, the transducer housings do
not need to be removed. If it is necessary to remove the transducer housings, the following
steps detail how to safely remove and reinstall them.

 WARNING
CUTTING HAZARD
Sharp edges may be present on the meter.
Wear appropriate personal protective equipment when working on the meter. Failure to do
so may cause serious injury.
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Figure 3-8: Transducer housing

 WARNING
FLUID CONTENTS MAY BE UNDER PRESSURE
When the meter is under pressure, DO NOT attempt to remove or adjust the transducer
housing.
Attempting to do so may release pressurized fluid, resulting in serious injury or equipment
damage.

 WARNING
FLUID CONTENTS MAY BE HAZARDOUS
The meter must be fully depressurized and drained before attempting to remove the
transducer housing. If fluid begins to leak from the transducer housing, immediately
reinstall it.
Failure to do so may cause serious injury or equipment damage.
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Figure 3-9: Transducer disassembly

A. Transducer cable (P/N 1-504-90-129) (max. length 15 ft.)
B. Coupling nut
C. Transducer retainer
D. Transducer
E. Transducer housing locking ring
F. Transducer housing

Procedure
1. Before removing the transducer housing(s), slowly vent all line pressure on

the meter to atmosphere pressure and drain the meter of fluid. Remove the
transducer(s) security seals.

2. Unscrew the coupling nut on the transducer cable to remove the cable from the
transducer retainer.

3. Unscrew the locking ring bolt and slide the locking ring from the transducer
housing.

4. Use a pair of needle nose pliers to grab the indexing key of the transducer and pull
the transducer from the housing.

5. Place a wrench on the hex of the transducer housing and slowly unscrew in a
counterclockwise direction from the meter. If fluid begins to leak from the meter
and or you hear or see fluids leaking from the threads, immediately stop and
reinstall the housing as the meter has not been fully drained and/or pressure has
not been relieved from the meter. Correct the issue before attempting to remove
the housing again.

6. Any time a transducer housing is removed from the meter the O-rings must be
replaced with new O-rings prior to reinstalling the housing in the meter. Apply a
light coat of Dow Corning 111(1) Silicone grease or equivalent to the O-rings. Make
sure the contoured side of the backup ring faces away from the transducer housing.
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NOTICE
Replace with new O-rings during transducer maintenance or after every ten years of
service.

7. Ensure that the transducer port, and transducer housing are clean and free of
debris.

8. Apply a small amount of nickel anti-seize compound (P/N 2-9-9960-134) to the outer
threads of the transducer housing. Apply a light coat of Dow Corning 1111 Silicone
grease or equivalent to the O-rings.

9. For LT-05 transducers only, place a small amount of the Dow Corning 111(1) Silicone
grease (P/N 1-360-01-651) on the face of the transducer to be installed. Using your
finger spread the silicone grease over the face of the transducer to create a thin,
even layer of silicone grease on the surface of the transducer face. There should be
no gaps or mounds of the silicone grease on the face of the transducer. Wipe off any
excess silicone grease from the sides of the transducer.

10. For all other transducers, place three drops of Dow Corning 200(1) Silicon Oil (12,500
Centistokes) (P/N 1-360-01-650) on the face of the transducer to be installed.

11. Insert the transducer (parts are keyed and can only be assembled one way) into the
new transducer housing. Do not use any lubricant on the O-rings or contacts of the
transducers.

NOTICE
Ensure that the transducers identified as belonging to end 1 are installed on end 1
(A1) of the meter housing and those identified as belonging to end 2 (A2) are
installed on end 2 of the meter housing.

12. Screw the transducer housing into the meter body. Ensure the transducer housing
threads are properly aligned (avoid cross-threading the housing) with the meter
body, then use a wrench on the hex bolt of the housing and slowly screw in a
clockwise direction. Also, ensure the transducer housing is fully seated against the
meter body per the table below 20 ft-lb (27 N-m).
Transducer housing Torque range Ft-lb

(N-m)
Transducer housing

LT-01/LT-03
LT-08/LT-09
LT-04/LT-05

20 (27)

A. Transducer housing

13. Slide the locking ring onto the transducer housing in an orientation so that the
locking ring bolt can be installed through the slot of the locking ring and into the
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threaded hole in the meter body. The recommended torque for installing the locking
ring bolt is 2.5 ft-lb (3.4 N-m).

Figure 3-10: Transducer installation

A. Transducer locking ring

14. Align the transducer cable connector with the indexing key on the back of the
transducer and hand-tighten the coupling nut to secure the cable (see Figure 3-10).

15. Apply power to the meter and slowly repressurize the meter to line pressure. Check
for leaks as the meter is pressurized. If you hear or see fluids leaking from the
threads, recheck all connections and resolve the problem. Then, slowly repressurize
the meter to line pressure.

16. Connect to the meter using MeterLink. Open the detailed view in Meter Monitor
and verify the meter is acquiring data, the transducers have good signals and flow
profiles for the chords are displayed.

17. Use the Tools → Transducer Swap-out menu path to access the Transducer Swap-
out Wizard. The Transducer Swap-Out Wizard is a utility that allows you to easily
update parameters such as path lengths, delay times, and delta times for chord.
This is necessary anytime housings have to be replaced for a chord. The wizard
guides you through updating which chords have been changed, which components
in the chords have been changed, as well as recalculating new path lengths based
on the information entered. This utility is only available while connected to a meter.
Collect and save a Maintenance Log and verify the meter is optimally performing.
If communicating with the meter via Modbus® or HART®, manually update the
parameters (see Manually modifying the Calibration Parameters).

18. Disconnect communications with the meter and close DUI.
19. If required, install the security wires on the transducer(s) cable and locking ring (see

Figure 3-6) for each component you replaced.
This completes the removal and installation of the transducer housing.
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3.3.1  Manually modifying the Calibration Parameters
Use the Tools → Transducer Swap-out utility in MeterLink to easily update parameters such
as path lengths, delay times, and delta times for chord. This is necessary anytime housings
have to be replaced for a chord or if the meter has performed a cold start. The wizard steps
you through selecting which chords have been changed, which components in the chords
have been changed, as well as recalculating new path lengths based on the information
entered. This utility is only available while connected to a meter. The length of the meter
body is found on the original calibration sheet supplied with the meter.

Figure 3-11: Transducer Swap Out Wizard

Chord select components page
When transducer pairs are replaced or the meter has performed a cold start, the
corresponding meter calibration parameters must be updated for accurate operation.
Select the chord parameters which have changed (see Figure 3-12, example: Transducers
and Housings are selected).
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Figure 3-12: Transducer Swap Out Wizard - Select Components Page

Update Chord parameters page
Enter the chord values for the removed components, the components added and the new
Delay time and Delta time on this page. After the values are entered, click the Write to
Meter button to apply the changes.
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Figure 3-13: Transducer Swap Out Wizard - Select Components Page

Calculated “L” value
New chord parameters “L” for Liquid Ultrasonic meters will be calculated by the equation:

Equation 3-1: Calculated “L” valueCurrentL + (RemovedHousing1 + RemovedHousing2) − (AddedHousing1 + AddedHousing2)
MeterLink™ may not be able to use the full precision of the values provided with the
replacement components but the resolution of the New Chord Parameter is equivalent to
the resolution to which it will be stored in the meter.
Chord “L” Dimension Calculation
The chord “L” dimension is calculated from the meter housing length and the transducer
housing lengths as shown in Equation 3-2. The lengths of the transducer housings are
etched on on the individual components. The length of the meter body is found on the
original calibration sheet supplied with the meter.

Equation 3-2: Chord “L” DimensionLcℎord = LMeterHousing − LHsng1 − LHsng2
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where Lcℎord = chord "L" dimension (in) (LA...LD)LMeterHousing = meter housing length (in)LHsng1 = transducer 1 housing length (in)LHsng2 = transducer 2 housing length (in)
3.4  Transducer cable removal and installation

Rosemount 3810 Series Ultrasonic Flow Meters have blue transducer cables and a
transducer cable nut that threads directly into the back of the transducer housing. The
cables use plastic glands that come with the meter.

Figure 3-14: Flow meter transducer cables and ports

A. Base enclosure transducer cable glands
B. Cable ties (two locations)
C. 3814 Ultrasonic Meter transducer port and locking ring
D. Transducer mount and transducer cable

 WARNING
FLUID CONTENTS MAY BE UNDER PRESSURE
DO NOT remove the transducer locking ring while the line is pressurized.
Failure to do so may cause serious injury or equipment damage.
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 WARNING
CUTTING HAZARD
Sharp edges may be present on the meter.
Wear appropriate personal protective equipment when working on the meter. Failure to do
so may cause serious injury.

The meter body ports are identified by stamped or cast lettering adjacent to the transducer
port (i.e. Model 3814 - A1, A2, B1, B2, C1, C2, D1, and D2).
Procedure

1. Remove power to the meter.
2. If installed, remove the security wire seals from the transducer cable connector

attached to the transducer cable nut and the transducer retainer attached to the
locking ring.

Figure 3-15: Transducer security seal removal

A. Transducer cable connector to transducer cable nut security wire
B. Transducer retainer to locking ring security wire

3. Unscrew the cable nut from the transducer housing and then, pull the cable from
the transducer housing (see Figure 3-4).

4. Cut the tie wraps for the transducer cable you are replacing.
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Figure 3-16: Flow meter transducer tie wraps

A. Base enclosure transducer cable glands
B. Cable ties (two locations for large size meters)
C. 3810 Series Ultrasonic Meter transducer port
D. Transducer mount and transducer cable

5. Use a wrench and loosen the cable gland (where the transducer cable enters the
Base Electronics Enclosure) until the transducer cable freely slides inside the gland.

6. Remove the two bolts holding the Base Enclosure cover to the Transmitter
Electronics Enclosure using a 6 mm Allen wrench.

7. Lift the Transmitter Electronics Enclosure from the Base Enclosure. It may be
necessary to remove the ground lug wire and loosen the conduit connections prior
to removal.

8. Carefully prop the Transmitter Electronics Enclosure to the side. Make sure the
enclosure is stable and does not roll.

 WARNING
CRUSHING HAZARD
During meter installation or removal, always place the unit on a stable platform or
surface that supports its assembled weight.
Failure to do so could allow the meter to roll, resulting in serious injury or
equipment damage.

9. Use a ⅛-in. (3 mm) flat-blade screw driver and disconnect the transducer wiring
terminal block from the Acquisition Module (see Figure 3-17).

10. Place the Transmitter Electronics Enclosure in a clean dry area. Be careful not to
dislodge or damage the enclosure gasket (see Warning above).
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11. Remove the transducer cable wires from the terminal block and slide the existing
cable through the Base Enclosure gland.

12. Use the existing cable and cut the new cable to same length.
13. Make sure the keyed parts are correctly aligned and insert cable connector into the

transducers and tighten the locking nut.
14. Route the cable through the gland on the Base Enclosure and pull the cable up

through the Base Enclosure to allow enough slack to strip the cable wire.
15. Strip the outer insulation, outer shield, and inner insulation to just inside the cable

gland using a utility knife. Verify that insulation of individual wires were not cut
while removing outer layers. Strip each wire ¼-in. and wire them to the Acquisition
Module terminal block. Check the label number (i.e. A1) on the Acquisition Module
and match it with the label on the cable. Securely tighten the mounting screws of
terminal block J1 and J2 as shown in Figure 3-17.

Figure 3-17: Flow meter Acquisition Module wiring

16. The relative position of the contacts is shown on the Acquisition Module label
adjacent to the terminal block. When terminating the connector wires, ensure that
the contacts clamp on the bare wires and not on the wire insulation. Leave the
connector plugged into the Acquisition Module while terminating the individual
wires.

17. Once the transducers are wired correctly, tighten the cable gland so that the
transducer cable is held securely in place. Pull the cable back through the gland
to remove the slack and configure the cable to follow the path of the existing cable.
(see Figure 3-14).

18. Repeat Steps 11 through 17 if you are replacing other cables.
19. Once all of the cables are replaced, dress with tie wraps (P/N 2-4-9158-001) in

groups of two; A1and C1, D1 and B1, A2 and C2, D2 and B2. Install one cable tie
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three inches from the Base Enclosure and another near the point the cables start to
bend and separate out into their respective port (see Figure 3-14).

20. Prop the Transmitter Electronics Enclosure at an angle on top of the the Base
Electronics Enclosure. Verify the enclosure is stable and does not roll.

21. Plug the Acquisition cable terminal block to J3 on the Acquisition Module. Use a flat
⅛-in. (3 mm) blade screw driver and securely tighten the terminal block mounting
screws to the Acquisition Module.

22. Wrap the excess cable around the Acquisition Module below the lip of the Base
Enclosure (this prevents pinching the cable when the Transmitter Electronics
Enclosure is installed).

23. Inspect the Transmitter Electronics Enclosure gasket for wear and replace it if
necessary.

24. If replacing the gasket, lubricate it with Dow Corning 111(2) (P/N 2-9-9960-135).
25. Attach one desiccant pack to the underside of the Base Enclosure cover.
26. Place the Transmitter Electronics Enclosure onto the Base Enclosure. Rotate the

Transmitter Electronics Enclosure until the mounting holes are correctly aligned with
the holes in the Base Enclosure.

27. Install the two screws with a 6 mm Allen wrench to secure the Transmitter
Electronics Enclosure to the Base Enclosure.

28. Reattach the external ground wire to the ground lug, reconnect the conduit and
prepare to seal the meter.

29. If required, install the security seal wire into and through one of the two holes in the
end cap. Choose holes that minimize counterclockwise rotation of the end cap when
the security wire is taut (maximum wire diameter 0.078-in.; 2.0 mm).

Figure 3-18: Transmitter Electronics Enclosure security seals

A. Transmitter Electronics Enclosure end cap
B. Security wire seals

30. Adjust the security wire, removing all slack and thread into the lead seal.
31. Crimp seal and cut wire ends to remove excess wire.

(2) Dow Corning 111 and Dow Corning 200 are trademarks of Dow Corning Corporation, U.S.A.
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32. If required, attach the security wire seals on the Base Enclosure.

Figure 3-19: Base Enclosure security seals

A. Transmitter Electronics Enclosure
B. Security wire seals
C. Transmitter Electronics endcap security latch
D. Base Enclosure

33. If required by the site operations manager, have an electrician fully test the
connections. After the Acceptance Test is witnessed and approved, seal the conduit.

34. Power down the system and apply the sealing compound to the conduit and allow to
set in accordance with manufacturer specifications.
This completes the transducer cable removal and installation procedure.

3.5  Replace the meter electronics
The following procedure should be performed by a qualified service technician or trained
personnel. Observe all warning labels on the meter before starting this procedure.
The Rosemount™ 3810 Series Ultrasonic Flow Meter Transmitter Electronics Enclosure
consists of the following:
• CPU Module assembly (P/N 1-360-03-014)
• Optional I/O Module (RS-232 or RS-485)
• I.S. Barrier Board (P/N 1-360-03-004)
• Power Supply (P/N 1-360-03-003)
• Backplane Board (P/N 1-360-03-07)
The Rosemount 3810 Series Ultrasonic Flow Meter Base Enclosure consists of the following:
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• Acquisition Module (P/N 1-360-03-013)
• Acquisition Cable (P/N 1-360-01-595)
Should the Rosemount 3810 Series Ultrasonic Flow Meter require disassembly in the field
(i.e., check boards, change switch settings, or replace boards), to prevent electrostatic
damage to the electronic boards, always use a ground strap while handling the circuit
boards. If one is not available, make sure you are electrically discharged before touching
the boards by first touching a metal surface such as a ground lug on the meter or a table.

Figure 3-20: Transmitter electronics

A. Backplane board location
B. Terminal end of Transmitter Electronics Enclosure
C. End cap security latch
D. Base enclosure with Acquisition Module

3.5.1  Replace CPU Module or optional I/O Module
Procedure

1. Remove power to the meter.
2. Refer to Figure 3-5 for the tools required to complete this procedure.
3. Disconnect security seals on the Transmitter Electronics Enclosure (see Figure 3-6),

loosen the end cap security latches using a 3 mm Allen wrench (see Figure 3-20) and
remove both end caps from the Transmitter Electronics Enclosure.

4. If replacing the CPU Module (terminal end of the enclosure) or the optional I/O
Module, use a ⅛-in. (3 mm) flat blade screw driver and disconnect the CPU Module
terminal blocks (or the optional I/O Module terminal blocks).
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Figure 3-21: CPU or I/O Module replacement

A. Terminal end of Transmitter Electronics Enclosure
B. CPU Module
C. Optional I/O Module
D. Power Supply board
E. Fuse
F. Internal chassis ground

5. Grasp the outer ends of the module you want to replace and pull it out of the
enclosure.

6. Insert the new CPU Module or I/O Module into the enclosure and firmly push
until the board is fully seated into the Backplane Board connectors and the lock
is engaged.

7. Replace the terminal blocks for the CPU Module and/or the Optional I/O Module and
tighten the flat head screws with a 3 mm flat blade screw driver.

8. If you are not replacing other electronics, replace the end caps and security latches
(requires a 3 mm Allen wrench). If required, install the security seal wire into and
through one of the two holes in the end cap.

a) Choose holes that minimize counterclockwise rotation of the end cap when
the security wire is taut (maximum wire diameter 0.078-in.; 2.0 mm).
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Figure 3-22: Transmitter electronic enclosure security seals

A. Transmitter Electronics Enclosure end cap
B. Security wire seals

9. Adjust the security wire, removing all slack and thread into the lead seal.
10. Cut wire ends to remove excess wire.
11. If replacing other electronics or the fuse, continue with Fuse Replacement,

Backplane replacement, I.S. Barrier Board replacement, or Power Supply Board
replacement and Acquisition Module replacement before replacing the end caps
and sealing the enclosure.
This completes the CPU Module or I/O Module replacement procedure.
If you encounter problems with this procedure, see the Emerson Customer Support
contact information in Emerson website: www.emerson.com.

3.5.2  Fuse Replacement
Procedure

1. Disable electrical power to the meter.
2. Refer to Figure 3-5 for the tools required to complete this procedure.
3. Disconnect the Transmitter Electronics Enclosure security seals (see Figure 3-18),

loosen the end cap security latch (requires a 3 mm Allen wrench) on the terminal
end of the enclosure (see Figure 3-20) and remove the end cap.

4. Use a ¼-in. (7 mm) standard flat head screw driver and remove the Fuse holder cap
(see Figure 3-21).
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Figure 3-23: Fuse holder cap

A. Fuse holder cap

5. Remove the fuse from the holder.
6. Insert the replacement fuse (Littlefuse #218002.HXP) into the Fuse holder.
7. Install the fuse cap into the holder and push until it is flush with the holder.
8. Turn the fuse cap clockwise ⅛ turn using a ¼-in. standard flat head screw driver.
9. If replacing other electronics, continue with Backplane replacement, I.S. Barrier

Board replacement, or Power Supply Board replacement and Acquisition Module
replacement before replacing the end caps and sealing the enclosure.

10. If you are not replacing other electronics, replace the end caps and security latches
(requires a 3 mm Allen wrench). If required, install the security seal wire into
and through one of the two holes in the end cap. Choose holes that minimize
counterclockwise rotation of the end cap when the security wire is taut (maximum
wire diameter 0.078-in.; 2.0 mm) (see Figure 3-22).

11. Adjust the security wire, removing all slack and thread into the lead seal.
12. Cut wire ends to remove excess wire.
13. Apply power to the meter.

This completes the fuse replacement procedure.

Maintenance and Troubleshooting Manual Meter maintenance
00809-0100-3814 January 2024

Rosemount 3814 Liquid Ultrasonic Flow Meter 59



3.5.3  Replace backplane, Intrinsically Safe (IS) barrier, or power
supply board
The following sections detail removal of the backplane board, the IS barrier board, and the
power supply board.

Backplane replacement
Procedure

1. If replacing the Backplane board, remove power to the meter.
2. Refer to Figure 3-5 for the tools required to complete this procedure.
3. Disconnect the Transmitter Electronics Enclosure security seals, loosen the end cap

security latches (3 mm Allen wrench required) and remove both end caps (see Figure
3-22).

4. Remove the CPU Module and the Optional I/O Module (if installed). See Figure 3-21
for board locations and associated terminal blocks.

5. Use a Phillips head screw driver and remove the four Backplane board screws and
captive star washers from the enclosure standoffs.

6. Pull the Backplane board out of the enclosure. This disconnects the I.S. Barrier
Board. Lay the Backplane board down with the Acquisition Cable still attached (the
Power Supply board may remain attached to the Backplane when you remove it
from the enclosure).

Figure 3-24: Backplane board replacement

A. Non-terminal end of Transmitter Electronics Enclosure
B. Power Supply board
C. I.S. Barrier board (inside the Guide Plate)
D. Acquisition cable
E. Backplane board
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7. Use a ⅛-in. (3 mm) flat head screw driver and disconnect the Acquisition
Cable terminal block from the Backplane. Unplug the Acquisition Cable from the
Backplane.

8. Remove the Power Supply (if it was not removed with the Backplane board) and I.S.
Barrier boards from the enclosure. The I.S. Barrier Board has a notched tab that
secures the board to the Guide Plate.

9. Attach the Acquisition Cable terminal block to the new Backplane Board and plug
the Power Supply Board and I.S. Barrier board into the Backplane board.

10. Insert the Backplane (with the Power Supply and I.S. Barrier Boards attached to the
Backplane) into the enclosure.

11. Fully seat the CPU Module and Optional I/O Module onto the Backplane board.
12. Install the four Phillips head screws to secure the Backplane to the enclosure

standoffs.
13. Reinstall the terminal blocks on the CPU Module, Optional I/O Module (if installed),

and the Power Supply board using a 3 mm flat head screw driver.

NOTICE
Ensure the terminal blocks are aligned with the guide plate openings.

14. Recheck the connections, wiring and switch settings before replacing the end caps.
15. If replacing other electronics, continue with the following sections before replacing

the end caps and sealing the enclosure.
16. If you are not replacing other electronics, replace the end caps, security latches,

reseal the meter and apply power. If required, install the security seal wire into
and through one of the two holes in the end cap. Choose holes that minimize
counterclockwise rotation of the end cap when the security wire is taut (maximum
wire diameter 0.078-in.; 2.0 mm) (see Figure 3-25).

17. Adjust the security wire, removing all slack and thread into the lead seal.
18. Cut wire ends to remove excess wire.
19. Apply power to the meter.

This completes the Backplane Board replacement procedure.
If you encounter problems with this procedure, see the Emerson Customer Support
contact information in Emerson website: www.emerson.com.

I.S. Barrier Board replacement
Procedure

1. If replacing the I.S. Barrier board, remove power to the meter.
2. Refer to Figure 3-5 for the tools required to complete this procedure.
3. Disconnect the Transmitter Electronics Enclosure security seals, loosen the end cap

security latches with a 3 mm Allen wrench and remove both end caps (see Figure
3-22).

4. Use a ⅛-in (3 mm) flat head screw driver and remove the terminal blocks from the
Power Supply board, the CPU Module and the Optional I/O Module (if installed). See
Figure 3-21 for board locations and associated terminal blocks.

5. Use a Phillips head screw driver and remove the four Backplane board screws from
the enclosure standoffs.

6. Pull the Backplane board out of the enclosure. This disconnects the I.S. Barrier
Board. Lay the Backplane board down with the Acquisition Cable still attached (the
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Power Supply board may remain attached to the Backplane when you remove it
from the enclosure).

Figure 3-25: I.S. Barrier board replacement

A. Non-terminal end of Transmitter Electronics Enclosure
B. Power Supply board
C. I.S. Barrier board (inside the Guide Plate)
D. Acquisition cable
E. Backplane board

7. Remove the I.S. Barrier Board from the Guide Plate on the right side of the
enclosure.

8. Install the new I.S. Barrier board onto the Backplane Board and seat the Power
Supply board onto the Backplane board.

9. Insert the Backplane, I.S. Barrier board and the Power Supply Board into the
enclosure.

10. Fully seat the CPU Module and Optional I/O Module onto the Backplane Board.
11. Attach the Backplane to the enclosure standoffs with the four Phillips head screws.
12. Reinstall the terminal blocks (3 mm Allen wrench required) on the CPU Module,

Optional I/O Module, I.S. Barrier Board and the Power Supply.
13. Recheck the connections, wiring and switch settings before replacing the end caps.
14. If replacing other electronics, continue with the following procedures before

replacing the end caps and sealing the enclosure.
15. If you are not replacing other electronics, replace the end caps and security latches

(3 mm Allen wrench required).
a) If required, install the security seal wire into and through one of the two holes

in the end cap.
b) Choose holes that minimize counterclockwise rotation of the end cap when

the security wire is taut (maximum wire diameter 0.078-in.; 2.0 mm).
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Figure 3-26: Transmitter electronic enclosure security seals

A. Transmitter Electronics Enclosure end cap
B. Security wire seals

16. Adjust the security wire, removing all slack and thread into the lead seal.
17. Cut wire ends to remove excess wire.
18. Apply power to the meter.

This completes the I.S. Barrier Board replacement procedure.
If you encounter problems with this procedure, see the Emerson Customer Support
contact information in Emerson website: www.emerson.com.

Power Supply Board replacement
Procedure

1. If replacing the Power Supply board, remove power to the meter.
2. Refer to Figure 3-5 for the tools required to complete this procedure.
3. Disconnect the Transmitter Electronics Enclosure security seals, loosen the end cap

security latches with a 3 mm Allen wrench and remove both end caps (see Figure
3-26).

4. Use a ⅛-in. (3 mm) flat head screw driver and remove the terminal blocks from the
Power Supply board, the CPU Module and the Optional I/O Module. See Figure 3-21
for board locations and associated terminal blocks.

5. Use a Phillips head screw driver and remove the four Backplane board screws from
the enclosure standoffs.
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Figure 3-27: Power Supply board replacement

A. Non-terminal end of Transmitter Electronics Enclosure
B. Power Supply board
C. I.S. Barrier board (inside the Guide Plate)
D. Acquisition cable
E. Backplane board

6. Pull the Backplane board out of the enclosure. This disconnects the I.S. Barrier
Board. Lay the Backplane board down with the Acquisition Cable still attached (the
Power Supply board may remain attached to the Backplane when you remove it
from the enclosure).

7. Plug the new Power Supply board and the I.S. Barrier Board onto the Backplane
Board.

8. Insert the Backplane, I.S. Barrier board and the Power Supply Board into the
enclosure and fully seat the CPU Module and Optional I/O Module.

9. Attach the Backplane to the enclosure standoffs with the four Phillips head screws.
10. Use a ⅛-in. (3 mm) flat blade screw driver and install the terminal blocks on the CPU

Module, Optional I/O Module, I.S. Barrier Board and the Power Supply.
11. Recheck the connections, wiring and switch settings before replacing the end caps.
12. If replacing other electronics, continue with Acquisition Module replacement before

replacing the end caps and sealing the enclosure.
13. If you are not replacing other electronics, replace the Transmitter Electronics

Enclosure end caps, install the end cap security latches (3 mm Allen wrench
required).

a) If required, install the security seal wire into and through one of the two holes
in the end cap.
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b) Choose holes that minimize counterclockwise rotation of the end cap when
the security wire is taut (maximum wire diameter 0.078-in.; 2.0 mm) (see
Figure 3-22).

14. Adjust the security wire, removing all slack and thread into the lead seal.
15. Cut wire ends to remove excess wire.
16. Apply power to the meter.

This completes the Power Supply Board replacement procedure.
If you encounter problems with this procedure, see the Emerson Customer Support
contact information in Emerson website: www.emerson.com.

Acquisition Module replacement

Procedure
1. Remove power to the meter.
2. Refer to Figure 3-5 for the tools required to complete this procedure.
3. If the installation has rigid conduit, use a medium size crescent wrench and loosen

the hex nuts on the Transmitter Electronics Enclosure. This should allow enough
slack to remove the Transmitter Electronics Enclosure from the Base Enclosure. If
the installation uses flexible conduit, you may not need to disconnect it from the
Transmitter Electronics Enclosure.

Figure 3-28: Conduit removal

A. Transmitter electronics enclosure
B. Conduit nuts

4. If the meter is equipped with security seals, remove the seals from the bolts on the
Base Enclosure.
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Figure 3-29: Transmitter Electronics Enclosure and Base Enclosure security seal
removal

A. Transmitter electronics enclosure
B. Base enclosure bolts and security seals

5. Use a 7/16-in. (6 mm) Allen wrench and remove the two hex head bolts and split lock
washers securing the Transmitter Electronics Enclosure to the Base Enclosure.

Figure 3-30: Transmitter Electronics Enclosure removal

A. Transmitter electronics enclosure
B. Base enclosure bolts
C. Base enclosure

6. Use a ⅛-in. (3 mm) flat head screw driver and disconnect the Acquisition cable
terminal block and the transducer wire terminal blocks from the Acquisition Module
inside of the Base enclosure.
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Figure 3-31: Acquisition Module cable and transducer wiring

A. Base Enclosure O-ring
B. Acquisition cable
C. Transducer wiring terminal blocks
D. Acquisition Module

NOTICE
Make sure the transducer cables are labeled for the chord configuration (A1, A2, B1,
B2, C1, C2, D1 and D2).

7. Remove the three Acquisition Module flat head screws and split lock washers, then
remove the Acquisition Module from the Base Enclosure.

8. Insert the new Acquisition Module into the Base Enclosure and secure with the three
split lock washers and flat head screws.

9. Reattach the terminal blocks onto the Acquisition Module ⅛-in. (3 mm) screw driver
for the corresponding chord (A1, B1, A2, B2, C1, C2, D1, or D2). Make sure the
transducer wires have good contact with the terminal block and the terminal block
screws are tight.

10. When you have completed attaching the transducer wire terminal blocks and the
Acquisition cable terminal block to the Acquisition Module, check the Base Enclosure
O-ring and reinstall if necessary.

11. Reattach the Transmitter Electronics Enclosure to the Base Enclosure with the two
hex head bolts and lock washers. Tighten bolts with a 6 mm Allen wrench.

12. Retighten or reattach the conduit to the Transmitter Electronics Enclosure using a
crescent wrench or channel lock pliers.

13. If required, install the security seal wire into and through one of the two holes in the
end cap. Choose holes that minimize counterclockwise rotation of the end cap when
the security wire is taut (maximum wire diameter 0.078-in.; 2.0 mm) (see Figure
3-22).

14. Adjust the security wire, removing all slack and thread into the lead seal.
15. Cut wire ends to remove excess wire.
16. Apply conduit sealing compound according to manufacturer’s recommendations.
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17. Apply power to the meter.
This completes the Acquisition Module replacement procedure.
If you encounter problems with this procedure, see the Emerson Customer Support
contact information in Emerson website: www.emerson.com.
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A  Conversion factors
A.1  Conversion factors per units of measurement

The following table includes conversion factors for many of the Metric and U.S. Customary
units of measure used with Rosemount™ 3814 Liquid Allocation Ultrasonic Flow Meters and
MeterLink™.
Table A-1: Conversion factors per units of measurement
Conversion factors Unit of measurement
(°F-32)x(5/9) -> °C
(°C+273.15) - > K
1 K/°C
5/9 °C/°F
10-6 MPa/Pa
0.006894757 MPa/psi
0.1 MPa/bar
0.101325 MPa/atm
0.000133322 MPa/mmHg
0.3048 m/ft
0.0254 m/in
103 dm3/m3

10-6 m3/cc (= m3/cm3)
(0.3048)3 m3/ft3

(0.0254)3 m3/in3

3600 s/h
86400 s/day
103 g/kg
0.45359237 kg/lbm
231 in3/gal
42 gal/bbl (barrel)
0.0037854 gal/m3

6.289811 bbl/m3

10-3 Pa•s/cPoise
1.488 Pa•s/(lb/(ft•s))
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A.2  K-Factor and inverse K-Factor
Equation A-1: Frequency volumetric flow rate K-FactorKFactor = FreqQFullScale(MaxFreq)3600s § ℎr( * )
and

Equation A-2: Frequency volumetric flow rate inverse K-FactorInvKFactor = (MaxFreq)(3600s § ℎr)( * )FreqQFullScale
where

KFactor = frequency “K-Factor” (pulses/volume**) (Freq1KFactor and Freq2KFactor)
InvKFactor = frequency “Inverse K-Factor” (volume**/pulse) (Freq1InvKFactor and
Freq2InvKFactor)
FreqQFullScale = frequency full-scale volumetric flow rate (volume**/time unit*)
(Freq1FullScaleVolFlowRate and Freq2FullScaleVolFlowRate)
MaxFreq = maximum frequency (Hz = pulses/time unit*) (Freq1MaxFrequency and
Freq2MaxFrequency)

(*) TimeUnit = time conversion factor depends on the VolFlowRate Time Unit data point:
• volume/second = 1 s/s
• volume/minute = 60 s/m
• volume/hour = 3600 s/h
• volume/day = 86400 s/d
(**) Volume = where the volume is selected via data points:
• Units System
• VolUnitUS

— gallons
— barrels

• VolUnitMetric
— cubic meters
— liters
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B  Engineering drawings
B.1  Rosemount 3810 Series Ultrasonic Flow Meter

Drawings
This appendix contains the following engineering drawing(s) for the ultrasonic meter:

DMC-004936 Rosemount 3810 Liquid Ultrasonic Flow
Meter System Wiring Diagram
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